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 4 AR400 Series Router
Introduction
The AR400 Series routers are high-performance broadband routers based 
around 10BASE-T/100BASE-TX switch ports. The AR440S and AR441S routers 
include an ADSL port, and a Port Interface Card (PIC) bay. The PIC bay adds 
expansion flexibility by allowing you to install a PIC card, available with ISDN 
(PRI E1/T1, BRI S/T, or BRI U), Ethernet, synchronous, or asynchronous ports. 
The AR450S has dedicated WAN and DMZ eth ports, and two asynchronous 
ports.

This Hardware Reference describes the hardware features of AR400 Series 
router models. Hardware and installation information for Port Interface Cards 
(PICs) can be found in the Port Interface Card Quick Install Guide and Port 
Interface Card Hardware Reference. This Hardware Reference does not cover 
software configuration or software installation procedures. For information on 
software, refer to the AR400 Series Router Software Reference.

Models Covered By This Reference
This Hardware Reference includes information on the following models:

■ AR440S

■ AR441S

■ AR450S

Hardware Reference updates can be found at 
www.alliedtelesyn.com/support/software/.

Where To Find More Information
The Documentation and Tools CD-ROM bundled with each router contains the 
complete document set for your router and, where applicable, its expansion 
options. The CD-ROM also includes tools for managing your router. 

The Document Set includes:

■ the Quick Install Guide for your router, which provides safety and statutory 
information, and outlines how to install the router

■ this AR400 Series Router Hardware Reference, which provides detailed 
information on the hardware features of AR400 Series routers

■ the AR400 Series Software Reference, which provides detailed information on 
configuring the router and its software

■ the Port Interface Card Quick Install Guide, which outlines the procedure for 
installing PICs

■ the Port Interface Card Hardware Reference, which provides detailed 
information on PICs

These documents can also be downloaded from the Support Site at 
www.alliedtelesyn.com/support/software/. 
C613-03086-00 REV C
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AR440S and AR441S ADSL Routers 
Each AR440S or AR441S router provides:

■ AR440S: One Asynchronous Digital Subscriber Line (ADSL) Annex A port

■ AR441S: One Asynchronous Digital Subscriber Line (ADSL) Annex B port 

■ Five 10/100 Mbps full duplex, Layer 2 switched Ethernet LAN ports. 

All LAN ports have Auto-MDI, however if Auto-MDI is turned off, then all 
ports are hardwired as MDI-X. Software can also force a port to either MDI 
or MDI-X.

■ One asynchronous port (ASYN0) 

The RS-232 (V.24) asynchronous serial port (ASYN0) has a DB9 male 
connector, is wired as a DTE port and can be used as a general purpose port 
for terminals, printers or modems. For pin wiring and default 
communication settings, see “Asynchronous Interfaces” on page 21. 

■ One PIC bay

Front and rear panels of the AT-AR440S router are shown in the following 
figure. The AR441S front and rear panels look the same, except for the name on 
the front panel. 

Specifications ■ 300 MHz RISC processor

■ 64 MBytes of SDRAM

■ 16 MBytes of flash memory (1 MByte reserved for boot block code)

■ 802.1Q tagged VLAN support

■ Universal AC power supply

■ On-board hardware encryption processor for DES, 3DES and AES. 

Some encryption options may require feature licenses.

ON

OFF

POWER

ASYN0ADSL

PIC BAY

5 3 1

4 2

100-240 VAC
50/60 Hz

2.1 A

AR440S
ADSL Router POWER SYSTEM PIC ADSL
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 6 AR400 Series Router
ADSL interfaces The ADSL port has an RJ-11 connector, and supports Dying Gasp. The speed 
depends on the DSLAM to which the router is connected, and the length and 
interference on the cable connecting them. The following table shows the pin 
wiring for the ADSL interface.

Port Interface Card
bay

The PIC bay can accommodate any of the following PICs:

• AT-AR020 PRI E1/T1 PIC, one Primary Rate E1/T1 port.

• AT-AR021(S) BRI-S/T PIC, one Basic Rate ISDN S/T port.

• AT-AR021(U) BRI-U PIC, one Basic Rate ISDN U port.

• AT-AR022 ETH PIC, one Ethernet LAN AUI/10BASE-T port.

• AT-AR023 SYN PIC, one Synchronous port with universal 50-way 
AMPLIMITE connector.

• When installed in an AR440S or AR441S router and operating in V.35 
mode, synchronous PICs have full V.35 functionality, but their output 
voltages may not be within the voltage range set by the V.35 
specification.

• Synchronous PICs installed in an AR440S or AR441S cannot be fully 
tested with Syntester.

• AT-AR024 ASYN4 PIC, four Asynchronous ports with RJ-45 
connectors.

• AT-AR026 4ETH PIC, four 10BASE-T/100 BASE-TX auto-negotiating 
ports with RJ-45 connectors.

• AT-AR027 VoIP-FXS PIC, two Foreign Exchange Subscriber (FXS) ports 
with RJ-11 connectors.

Environmental
conditions

■ Operating temperature range: 0 to 50º C (32º to 122º F)

■ Storage temperature range: -25 to 70º C (-13º to 158º F)

■ Relative humidity range - Storage: 5 to 95% non-condensing

■ Relative humidity range - Operating: 5 to 80% non-condensing

■ Operational altitude: 3,000 metres maximum (10,000 feet)

Power supply The routers have a universal AC input connector and a power switch on their 
rear panel. The routers require a power input of 100-240 VAC and 50–60Hz.

! Caution  Some interfaces that may be installed in the router are not 
transformer isolated. This means they will be referenced to the frame 
ground of the equipment and may be damaged if connected to an 
interface on another piece of equipment which is at a different ground 
potential. 

Pin* Function

1 Not connected

2 Not connected

3 ADSL+

4 ADSL-

5 Not connected

6 Not connected

*Pins are numbered from left to right. 
C613-03086-00 REV C
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AR440S, AR441S
LEDs

The following table shows functions of the AR440S and AR441S router LEDs.

LED State Function

Power Green The router is receiving power and the power 
switch is ON.

System Red Lit briefly during router start up, or the router 
is malfunctioning.

Red flashing The fan has failed.

Off Normal operation.

PIC Green A port interface card (PIC) is correctly installed 
and has been detected by the router.

Off No PIC is installed, or the router has not 
recognised the PIC.

1 - 5 Green A 100 Mbps link has been established through 
the corresponding switch port.

Green flashing Data is being transmitted through the 
corresponding switch port at 100 Mbps.

Amber A 10 Mbps link has been established through 
the corresponding switch port.

Amber flashing Data is being transmitted through the 
corresponding switch port at 10 Mbps.

Off No link is present through the corresponding 
port.

ADSL Green A link has been established through the ADSL 
port. It is ready to send or receive data.

Green flashing fast Data is being transmitted or received through 
the ADSL port.

Green flashing slow 
(1 sec) 

The ADSL port is in Loopback mode.

Amber The ADSL DSP is initialised and the port 
handshakes (looking for tones) or is physically 
disconnected.

Amber flashing The ADSL port has found tones, and is training 
to negotiate the link.

Green and amber 
alternating

There is a fault in the ADSL port.

Off The ADSL port is disabled, or the ADSL DSP is 
initialising
C613-03086-00 REV C
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AR450S Router
Each AR450S provides:

■ Five 10/100 Mbps full duplex, Layer 2 switched Ethernet LAN ports. 

All LAN ports have Auto-MDI, however if Auto-MDI is turned off, then all 
ports are hard-wired as MDI-X. Software can also force a port to either MDI 
or MDI-X.

■ Two 10/100 Mbps full-duplex Eth WAN ports

■ Two asynchronous ports (ASYN0 and ASYN1)

The RS-232 (V.24) asynchronous serial ports (ASYN0, ASYN1) has a DB9 
male connector, is wired as a DTE port and can be used as a general purpose 
port for terminals, printers or modems. For pin wiring and default 
communication settings, see “Asynchronous Interfaces” on page 21. 

The following figure shows the front and rear panels of the AT-AR450S router. 

Specifications ■ 400 MHz RISC processor

■ 64 MBytes of SDRAM, expandable to 256 MBytes

■ 16 MBytes of flash memory (1 MByte reserved for boot code)

■ On-board hardware encryption processor

■ 802.1Q tagged VLAN support

■ Universal AC power supply

Random Access
Memory (RAM)

The AR450S has 64MB of SDRAM provided on a single DIMM. 128MB and 
256MB ECC SDRAM are also supported. See your authorised Allied Telesyn 
distributor or reseller for upgrade options. Other supplier’s DIMMs are not 
approved, and therefore not supported, but may function correctly.

The amount of DRAM present in a router can be checked using the command:

show system

The DRAM and FLASH fields show the amounts of DRAM and flash memory, 
respectively.
C613-03086-00 REV C
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Encryption processor Some encryption options require feature licences. The on-board encryption 
processor has the following features:

• single and triple DES, and AES symmetric encryption algorithms

• SHA-1 and MD-5 hashing support

• RSA and DH public key support.

Environmental
conditions

■ Operating temperature range: 0 to 40º C (32º to 104º F)

■ Storage temperature range: -25 to 70º C (-13º to 158º F)

■ Relative humidity range—storage: 5 to 95% non-condensing

■ Relative humidity range—operating: 5 to 80% non-condensing

■ Operational altitude: 3,000 metres maximum (10,000 feet)

Power supply The router has a universal AC input connector and a power switch on its rear 
panel. The router requires a power input of 100-240 VAC and 50–60Hz.

AR450S LEDs The following table shows functions of the AR450S LEDs.

LED State Function

Power Green The router is receiving power and the power 
switch is in the ON position

System Amber Lit briefly during router start up, or the router is 
malfunctioning.

Amber flashing The router fan has failed.

Off Normal operation

Full Green The corresponding port is operating at full-duplex

Off The corresponding port is operating at half-
duplex

Link/ACT Green A link has been established through the 
corresponding port

Flashing Data is being transmitted through the 
corresponding port

Off No link is present through the corresponding port

100M Green The corresponding port is operating at 100Mbps

Off The corresponding port is operating at 10Mbps
C613-03086-00 REV C
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Online Documentation
This section provides a step-by-step guide to accessing documentation on the 
CD-ROM. Adobe Acrobat Reader must be installed to view the documentation.

To use the CD-ROM, follow these steps

1. Insert your router’s Documentation and Tools CD-ROM in the CD-ROM drive.

2. If the Welcome screen does not appear.

Select "Run" from the Start Menu (Windows 98, 2000 or XP).

Type d:\start.exe (where d: is the CD-ROM drive letter) and click OK.

3. To view a document.

Click on the document title.

4. To navigate around PDF documents.

Use the toolbar buttons, keyboard shortcuts, or commands from the 
Document menu to page through the document.

Click on a bookmark, thumbnail or hypertext link to jump to a specific 
section or topic.

Use the Search command to search for keywords or phrases.

For more information about using the Adobe Acrobat Reader, select 
"Reader Guide" from the Help menu.

5. To install any of the tools included on the CD-ROM.

Click on a link in the Welcome screen. 
C613-03086-00 REV C
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AT-TFTP Server
This section provides information on how to access and use AT-TFTP Server. 
AT-TFTP Server can be used to transfer configuration files as well as to 
download software patches and releases.

To use AT-TFTP Server

1. If AT-TFTP Server has not yet been installed.

Install it now from the router’s Documentation and Tools CD-ROM.

To install AT-TFTP server, choose AT-TFTP Server from the Start > 
Programs > Allied Telesyn > AT-TFTP Server menu.

2. To set preferences for the AT-TFTP Server.

Select "Options" from the File menu to display the "Set Preferences" dialog 
box.

The "Default file transfer directory" field specifies the directory that 
AT-TFTP Server will read from or write to for file requests that do not 
include a directory specification.

To prevent unauthorised access to private directories, enter a path name in 
the "Restrict to directory" field. AT-TFTP Server will use only the specified 
directory, even if file requests contain references to other directories.

Select "Read only" to prevent files being written to the PC. To use the PC to 
archive router scripts created using the router's create config command, 
select "Read Write".

Make necessary changes and click "OK".

3. To load a file from AT-TFTP Server to the router.

On a terminal connected to the router, type the command:

load method=tftp file=filename server=ipadd dest=flash

where filename is the name of the file to download and ipadd is the IP 
address of the PC running AT-TFTP Server.

4. To save a TFTP Server log.

Select "Save As" from the File menu.

TFTP requests are logged to the AT-TFTP Server main window.
C613-03086-00 REV C
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Using Windows Terminal and 
HyperTerminal
You can use a PC running terminal emulation software as the manager console, 
instead of a terminal. There are many terminal emulation applications 
available for PCs, but the most readily available are the Terminal and 
HyperTerminal applications included in Microsoft Windows 98, 2000, and 
XP Professional. In standard Windows installations, HyperTerminal is 
available from the Communications submenu.

The key to successful use of terminal emulation software with the router is to 
configure the software and router with matching communications parameters. 
The following procedure can be applied to most terminal emulation programs. 
Dialog boxes in the procedure are from Windows 2000 and XP Professional.

To configure Windows HyperTerminal for 2000 and XP Professional

1. Start the program in Windows by doing one of the following:

• Select Programs > Accessories > Communications > HyperTerminal.

• Double-click the Hypertrm.exe icon.

2. In the Connection Description dialog box:

• Enter a name for the connection, such as Admin.

• Select an icon from the scrollable list and click the OK button.
C613-03086-00 REV C
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3. In the “Connect using” field on the Connect To dialog box, select the COM 
port on the PC used to connect to the router. and click the OK button. 

4. In the COMn Properties dialog box, set port parameters as follows, and click 
the OK button.
C613-03086-00 REV C



 14 AR400 Series Router
5. From the main HyperTerminal window, select Properties from the File 
menu. Click the Settings tab, and set the Properties dialog box as follows.

6. Click ASCII Setup to display the ASCII Setup dialog box, and ensure the 
following options are not selected:

• Echo typed characters locally

• Append line feeds to incoming line ends

Set other parameters as necessary and click the OK buttons on both dialog 
boxes to close them.   
C613-03086-00 REV C
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7. Save the current session by selecting Save from the File menu on the main 
HyperTerminal window. This creates a connection icon with the name you 
assigned in the HyperTerminal group. 

To use the configuration, double-click the connection icon. When the 
HyperTerminal window appears, press the Enter key several times; the 
router’s login prompt is then displayed.

Router Start-Up
At start-up, the manager can choose to run either the software release stored in 
the flash boot block, or the software release specified by the INSTALL 
parameters previously set using the set install command.

All code is executed out of system RAM. At power-up the boot code is loaded 
from the flash boot block to RAM. The boot code checks the INSTALL 
information then reloads RAM with the selected temporary, preferred, or default 
install release (stored in flash) and runs this code.

The release is uncompressed as it loads to RAM. This may take 10–30 seconds. 
At this point, any required patches are loaded from the flash file system. Any 
patch is also uncompressed as it loads to RAM. This procedure ensures that the 
code runs at maximum speed, and allows updates to be made to the code. 
Updates can be downloaded over the network from a TFTP server and stored 
in the flash file system until required at power-up.

To download software onto the router, see the Upgrade chapter in the Software 
Reference.

All router software, patches, and configuration settings are stored as files in 
flash memory. Typically, the following files will be present in flash:

■ The current installed software release. Additional software releases may 
also be present.

■ The current installed patch, if any. Additional patches may also be present.

■ The command line help file. All command help is stored in a separate text 
file designed to be language independent. The command help file is loaded 
with a software release.

■ The boot script boot.cfg. The boot script contains standard router 
commands (executed on start-up to configure the router).

■ Additional user-defined configuration scripts containing commands to 
configure the router for different functions. These scripts are created using 
the built-in editor, the add script command (in the Scripting chapter, 
Software Reference), or the create config command (in the Upgrade chapter, 
Software Reference).

Configuration information is stored in flash memory as configuration scripts. 
These scripts contain standard router commands. When a configuration 
command is entered at the command prompt from a terminal, terminal 
emulation program, or Telnet session, the command alters the dynamic 
configuration only; this is not saved over a power cycle. To ensure that 
configuration changes resulting from such commands are retained across a 
power cycle, the dynamic configuration must be saved as a configuration 
script, using the create config command.
C613-03086-00 REV C
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Start-up process When the router starts up following either a power cycle or an operator-
initiated reboot (using the restart reboot command in the Upgrade chapter, 
Software Reference), the following sequence of operations is performed:

1. Perform start-up self tests.

2. Load the flash boot block release as the INSTALL boot into the router’s 
RAM.

3. Prompt the manager for changes to the default start-up procedure: 

Force EPROM download (Y)?

The manager may press one of the keys listed in the table in “Router start-
up sequence keystrokes” on page 17 to override the default installation 
procedure.

4. Check the INSTALL information to determine which release to load and 
run, according to the INSTALL parameters, and the manager’s response to 
the previous prompt. The INSTALL parameters determine which release 
and patch the router loads and runs, unless you press one of the keys in the 
table in “Router start-up sequence keystrokes” on page 17. 

5. Load the required release specified by the INSTALL parameters from the 
flash file system as the main boot.

6. Start the router.

7. Execute the boot configuration script, if one has been configured. The boot 
configuration script is either a configuration file set using the set config 
command from the Upgrade chapter, or the file boot.cfg file, if there is one.)

The router sends a series of start-up messages to asyn0 (the console or terminal 
port). For an example see the following figure. 

Example start-up
messages

 

After the self tests are complete, the manager is given the option of forcing a 
mandatory boot from the flash boot block release. The following message is 
displayed on the terminal connected to the console port (asyn0) and the router 
pauses:

Force EPROM download (Y)?

INFO: Self tests beginning.
INFO: RAM test beginning.
PASS: RAM test, 65536k bytes found.
INFO: Self tests complete
INFO: Downloading router software.
Force EPROM download (Y) ?
INFO: Initial download successful
INFO: Initialising Flash File System.
INFO: IGMP packet trapping is active for IGMP snooping, L3FILT 
is activated
INFO: Executing configuration script <flash:boot.cfg>
INFO: Router startup complete

Login:
C613-03086-00 REV C
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Router start-up
sequence keystrokes

If a key is not pressed within a few seconds, the start-up process continues and 
all steps in the start-up sequence are executed. Pressing certain keys on the 
terminal immediately after the “Force EPROM download” message is 
displayed changes the router start-up process as described in the following 
table.

Router start-up
message classes

During the start-up process the router generates four different types of 
messages. All messages are preceded by one of the words INFO, PASS, FAIL, 
or ERROR. The meaning of these words in the context of the messages is 
shown in the following table.

Messages and their meanings are:

INFO: Self tests beginning.

The code loader tests are about to begin.

INFO: RAM test beginning.

The RAM tests are about to begin.

PASS: RAM test, 65536k bytes found.
The RAM test passed, and the indicated amount of memory was found 
and will be used in the router. (The amount of memory depends on the 
router model.)

ERROR: RAM test 5. Error address = 00345678.
A RAM test failed, at the given address. In the example, it was the fifth 
test run. The RAM test repeats until it passes, so a number of messages 
like this may appear. This fault means that the memory system is faulty. 
If the fault continues, contact your distributor or reseller immediately.

INFO: Self tests complete.

The start-up tests have finished.

INFO: Downloading router software.

The process of downloading the router software from ROM is about to 
begin.

Pressing key... Forces the router to...

(no key pressed) After a few seconds, the router start up process continues.

[Y] Load the release, without any patches, from ROM onto the RAM, and run 
the full release.

[S] Load and run the release and patch determined by the INSTALL 
parameters from flash, ignoring any boot script or previous configuration 
stored in flash memory.

Message Meaning

INFO An informational message that an action has been taken by the system.

PASS An informational message that a test has been completed successfully.

ERROR An error message that a test has failed, but the system will continue to 
operate.

FAIL An error message that a fatal error condition has caused the system to 
halt in an unrecoverable fashion.

WARNING A serious error has occurred, which may indicate hardware failure.
C613-03086-00 REV C



 18 AR400 Series Router
ERROR: Code load retried.
FAIL: Code load failed.

The load of the code from ROM to RAM failed. The load is retried a 
number of times. Each time a failure occurs the ERROR message is 
displayed. If the maximum number of attempts is reached, the FAIL 
message is displayed.

ERROR: Vector load retried.
FAIL: Vector load failed.

The load of the vector table from ROM to RAM failed. The load is retried 
a number of times. Each time a failure occurs the ERROR message is 
displayed. If the maximum number of attempts is reached, the FAIL 
message is displayed. Contact your authorised Allied Telesyn 
distributor or reseller.

INFO: Initial download successful.

The start-up tests and download from ROM are complete, and the 
specified router software is about to be started. It takes a few seconds to 
decompress the software release.

FAIL: Unexpected exception. Offset = 40, Addr = 0100045e.

An unexpected exception occurred while the start-up was executing. 
The vector offset and the program counter when the exception occurred 
are given in the message. Contact your distributor or reseller.

INFO: Executing configuration script <script-name>

The configuration commands stored in <script-name> are being 
executed. If an error is found in the script, one or more ERROR 
messages will be displayed.

INFO: Router startup complete.
The start-up process is complete and the router is now operational.

INFO: Initialising Flash (This may take some time) 
The flash file system was found to be corrupt. The router is now re-
initialising the flash device to a "good" state. The process will take at 
least 4 minutes, depending on the router.

INFO: IGMP Snooping is activated.
IGMP snooping has been enabled.

INFO: IGMP packet trapping is active for IGMP snooping, L3FILT 
is activated

IGMP snooping has been enabled.

WARNING: IGMP Snooping not active, failed to enable ports. 

The IGMP snooping could not be activated on the switch ports. This 
may indicate a hardware failure. Contact your authorised distributor or 
reseller.
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Flash Memory
Flash memory is a non-volatile, reprogrammable, memory storage device for 
router software releases, allowing upgrades to be remotely loaded from any 
WAN or LAN port. Flash memory is also used to store other types of data such 
as patches, logs and configurations. 

Testing flash
memory

There are several ways to check that onboard flash memory is installed and 
operating correctly. First, check that the router has recognised the flash 
memory by displaying system information (Figure 1) with the command:

show system

Figure 1: Example output from the show system command for the AT-AR450S router  

The second part of the display shows the types and sizes of memory installed 
in the router. If the flash memory size is lower than expected, then the router’s 
boot process has not correctly detected or recognised the flash memory’s 
presence. If recognition fails, contact your authorised Allied Telesyn distributor 
or reseller.

If the flash is recognised, display flash memory size, device type, and location 
with the command:

show flash physical

A typical display is shown in Figure 2 on page 20.

Router System Status                            Time 02:25:09 Date 25-May-2004.
Board      ID  Bay Board Name                          Rev    Serial number
--------------------------------------------------------------------------------
Base      191      AR450                               M1-0   57681308
--------------------------------------------------------------------------------
Memory -   DRAM : 65536 kB    FLASH : 16384 kB    
--------------------------------------------------------------------------------
SysDescription
Allied Telesyn AR450 version 2.6.1-00 20-Aug-2003
SysContact

SysLocation

SysName

SysDistName

SysUpTime
310708 ( 00:51:47 )
Boot Image      : 450_107.fbr size 874084 11-May-2004
Software Version: 2.6.1-00 20-Aug-2003
Release Version : 2.6.1-00 20-Aug-2003
Patch Installed : NONE
Territory       : usa
Help File       : help.hlp

Configuration
Boot configuration file: ip.cfg (exists)
Current configuration: ip.cfg

Security Mode   : Disabled

Warning (2048284): No patches found.
C613-03086-00 REV C



 20 AR400 Series Router
Figure 2: Example output from the show flash physical command for an AR450S

Lastly, check the Flash File System (FFS) to ensure that it has successfully 
formatted the flash. Use the command:

show file

If flash memory has been used in the past, it may already be formatted and 
contain files. With erased or new flash memory that has been correctly 
formatted, an 80 byte hidden system file is present. A typical display for an FFS 
is shown in Figure 3 on page 20.

Figure 3: Example output from the show file command for an AR450S

total size ............ 16 MBytes
   available to FFS ... 15 MBytes
   available to boot .. 1 MBytes
device type ........... 28F128
devices ............... 1
location .............. built in
programming power ..... off
block erase time ...... 1000 milliseconds
total erase blocks .... 128
   FFS erase blocks ... 120
   Boot erase blocks .. 8
erase block size ...... 128 kBytes
erase bit state ....... 1
page buffers .......... 1
size of page buffer ... 32 bytes

Filename              Device        Size     Created               Locks
-------------------------------------------------------------------------
450-252a.hlp            flash         140586   09-May-2003 17:01:15    0
54-252.rez              flash         2316676  11-Dec-2003 08:49:27    0
54-261.rez              flash         2424476  21-Aug-2003 12:11:56    0
54252-03.paz            flash         150916   11-Dec-2003 08:55:25    0
config.gui              flash         363      04-Mar-2004 15:16:09    0
config.ins              flash         32       11-Dec-2003 14:00:07    0
d450se02.rsc            flash         2303244  11-Dec-2003 09:00:23    1
feature.lic             flash         39       25-Jun-2003 13:41:29    0
random.rnd              flash         3904     02-Mar-2004 09:14:48    0
release.lic             flash         64       28-Mar-2003 23:29:14    0
ssh.key                 flash         321      02-Apr-2003 23:18:14    0
-------------------------------------------------------------------------
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Asynchronous Interfaces
Asynchronous interfaces on the router, also known as RS-232 (V.24) terminal 
ports (labelled ASYN0, ASYN1, RS-232 or CONSOLE) use DB9 male 
connectors. The default communications settings are:

• 9600 bps

• 8 data bits

• 1 stop bit

• no parity

• hardware flow control

The pin wiring is shown in the following table, matches most building wiring 
schemes. 

The pin wiring for the RJ-45 connectors on the AR024 4ASYN PIC is described 
in the Port Interface Card Hardware Reference.

Asynchronous interfaces follow the RS-232 standard. A range of speeds is 
selectable using the set port command (Interfaces chapter, Software Reference). 

Not all signals need to be connected. In particular, both DCD and CTS are not 
required unless the interface has been specifically set up to use them. See the 
Terminal Server chapter, Software Reference for more details. A typical terminal 
connection requires only RXD, TXD and GND, but refer to the equipment 
manual for the connected device for more specific data.

Port Interface Cards (PICs)
You can install a PIC (Port Interface Card) in any AR400 Series routers except 
the AR450S. The sections describing each router model (earlier in this 
Reference) list the PICs that can be installed in each model. Installation 
information for PICs is in the Port Interface Card Quick Install Guide. Detailed 
PIC hardware information is in the Port Interface Card Hardware Reference.

The PIC Quick Install Guides and Hardware References are included on the 
Documentation and Tools CD-ROM bundled with all AR400 Series routers. 
They can also be downloaded from the Support Site at 
www.alliedtelesyn.com/support/software/.

Pin* Function Signal Direction

1 DCD Input to router

2 RXD Input to router

3 TXD Output from router

4 DTR Output from router

5 GND

6 DSR

AR450S: Not connected

Input to router

7 RTS Output from router

8 CTS Input to router

9 Not connected

 * Pins are numbered from left to right.
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RS-232 Terminal and Modem Cables
This section describes how to make cables for connecting the router to 
networks, terminals, and printers.

■ “DB9 female to DB9 female cable” 

■ “DB9 female to DB9 male cable” on page 23

For information about cables to connect to an AR024 ASYN 4 PIC, see the  Port 
Interface Card Hardware Reference.

The RING input is available only on asynchronous ports on expansion cards. It 
is not available on asynchronous ports on base CPU boards.

DB9 female to
DB9 female cable

To connect the router’s asyn port to a PC, terminal or router with a DB9 male 
connector wired as DCE, use a DB9 female to DB9 female null modem cable 
wired as in the following diagram. 

Figure 4: Cable wiring for DB9F to DB9F cable (DTE to DTE) (null modem) 

DB9 Female
(to router/DTE)

DB9 Female
(to PC/terminal/DTE)

4
6
3
2

1
5
8
7
9

1

2
3
4
6
5
7
8
9

Notes:
(1) → Output from router; ← Input to router.
(2) Cable version 1.0.

DB9FDB9F

←

←
→
→
Not Connected

→
Not Connected

(DCD)

(RXD)
(TXD)
(DTR)

(GND)
(RTS)
(CTS)

Cable

Pin 9 Pin 6

Pin 5 Pin 1

DB9 Female — Pin View
Pin 9 Pin 6

Pin 5 Pin 1

DB9 Female — Pin View
C613-03086-00 REV C



Hardware Reference  23
DB9 female to
DB9 male cable

To connect the router’s asyn port to a modem with a DB9 female connector 
wired as DCE, use a cable wired as in the following diagram.
 

Notes:
(1) → Output from router; ← Input to router.
(2) Cable version 1.0.

DB9MDB9F

1
2 
3 
4 
5
6
7
8

1
2
3
4
5
6
7
8
9

Cable

Pin 9 Pin 6

Pin 5 Pin 1

DB9 Male   Pin View
Pin 9 Pin 6

Pin 5 Pin 1

DB9 Female   Pin View

DB9 Female 
(to router/DTE)

DB9 Male
(to modem/DCE)

← (DCD)
← (RXD)
→ (TXD)
→ (DTR)
    (GND)
Not connected
→ (RTS)
← (CTS)
     (RING)

(DCD)
(RXD)
(TXD)
(DTR)
(GND)
(DSR) Not needed
(RTS)
(CTS)
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Test Facility
A Test Facility designed to test the router’s physical interfaces and expansion 
options is built into the router software. The Test Facility can be thought of as a 
specialised interface module like PPP or Frame Relay. Although the router can 
continue to operate normally during specific tests, any interfaces being tested 
are dedicated to the Test Facility. For more information on the Test Facility’s 
operation, see the Test Facility chapter, Software Reference.

! Caution   Do not connect to the router via a port you are testing. 

The routers and PICs support a wide range of interface types, including 
Ethernet, asynchronous, synchronous, Basic Rate ISDN and Primary Rate 
ISDN. Each interface type (except Ethernet interfaces on the AT-AR026 PIC) 
can be tested independently using the Test Facility software. Most tests, 
however, will also require the use of a loopback plug. See “Loopback Plugs” on 
page 26.

The following examples show how to test specific interfaces. If a test fails, 
contact your authorised Allied Telesyn distributor or reseller.

To display test results, use the command:

show test

The following figure shows sample output from the show test command.

Figure 5: Example output from the show test command on an AR450S 

Board      ID  Bay Board Name                          Rev    Serial number
----------------------------------------------------------------------------
Base      190      AR450                               M1-0   57687095

                                              Duration       Details  
Interface  State    Result              Type  (minutes)  Data( %OK )  Control
----------------------------------------------------------------------------

  eth0    complete  good                trans        0    -     -      -
                                        TP           2   good(100.0)   -
                                        ENDEC        0    -     -      -
                                        MAC          2   good(100.0)   -

  eth1    complete  good                trans        0    -     -      -
                                        TP           2   good(100.0)   -
                                        ENDEC        0    -     -      -
                                        MAC          2   good(100.0)   -

  port1   complete  good                 -           2   good(100.0)   -
  port2   complete  good                 -           2   good(100.0)   -
  port3   complete  good                 -           2   good(100.0)   -
  port4   complete  good                 -           2   good(100.0)   -
  port5   complete  good                 -           2   good(100.0)   -

  asyn0   complete  good                 -        1000   good( 99.0)  good

  enco0   no test     -                  -           -    -     -      -
----------------------------------------------------------------------------
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Asynchronous
interface test

Asynchronous interfaces require a loopback plug to be installed before the test 
will operate. See “Loopback Plugs” on page 26 for details of how to make a 
loopback plug. To start a test of an asynchronous interface, use the command:

enable test int=asynn

where n is the interface number. This runs the test for 4 minutes. Use the show 
test command (Test Facility chapter, Software Reference) to observe the test 
progress.

Ethernet interface
test for eth and

switch ports

A loopback plug is required to run the first part of the Ethernet test. See 
“Loopback Plugs” on page 26 for details of how to make a loopback plug. 

To start a test of an eth interface, use the command:

enable test int=ethn

where n is the Ethernet interface number. 

To start a test of a switch port, use the command:

enable test int=portn

where n is the switch port number. 

This runs the test for 4 minutes. Use the show test command (Test Facility 
chapter, Software Reference) to observe the test progress.

AT-AR026 PICs   The Test Facility does not test AT-AR026 4ETH PICs.

ADSL interface tests No loopback plug is required to test an ADSL interface. To start a test of an 
ADSL interface, use the command:

enable test int=adsln 

where n is the interface number. Use the show test command (Test Facility 
chapter, Software Reference) to observe the test progress.

WAN port tests To fully test synchronous interfaces, an external tester (available from your 
authorised Allied Telesyn distributor or reseller) is required. A loopback plug 
is not required to test BRI interfaces.

To start a WAN interface test, use the command:

enable test int=synn

or

enable test int=brin

where n is the WAN interface number. This runs the test for 4 minutes. Use the 
show test command (Test Facility chapter, Software Reference) to observe the 
test progress.
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Loopback Plugs
Loopback plugs are used in conjunction with the Test Facility software (see the 
Test Facility chapter) to test the router’s physical interfaces. The purpose of a 
loopback plug is to connect the output pins on the interface to the input pins so 
that any data transmitted over the interface is looped back and received at the 
same interface.

On interfaces with control signals, these are also looped back. The data 
received on the interface is compared with the data transmitted to determine 
whether or not the interface is functioning correctly. In order to produce a 
comprehensive test report, most tests performed by the Test Facility require a 
loopback plug to be inserted in the interface being tested.

Some interfaces (e.g., the synchronous ports) require a specially built external 
testing device (available from your authorised Allied Telesyn distributor or 
reseller) to be used in conjunction with the Test Facility.

Asynchronous port
loopback plug

To test an asynchronous (RS232/Console) port, use a loopback plug as 
described in the following figure. 
 

Switch or eth port
loopback plug

To test an eth or switch port, use a loopback plug as described in the following 
figure. 

DB9 Male Asynchronous Port Loopback Plug (DB9 female connector)

1
2
3
4
5
6
7
8
9

DB9FLOOP

Pin 9 Pin 6

Pin 5 Pin 1

DB9 Female — Pin View

Not 
connected
Not 
connected
 •Not 

Twisted Pair (TP) Loopback Plug (RJ45 connector)

1
2
3
4
5
6
7
8

12345678

End view
of plug

TX+
TX-
RX+

RX-

TPLOOP
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Restricted Procedures

Diagnostics
The router software includes a set of diagnostic programs. These programs 
perform basic level checks of all system components. They do not run in 
conjunction with the normal operating code, and require that the system be 
totally dedicated to their use. A detailed knowledge of the way your router 
hardware functions is necessary if diagnostics are to be used effectively. 

! Caution   Diagnostic mode should be used by authorised service 
personnel only. Unauthorised use of diagnostic mode may cause the 
router to cease functioning.

To enable diagnostics mode

The router does not function as a router while diagnostic mode is running. 
Diagnostics do not perform checks on AT-AR026 PICs.

1. Connect a terminal to the console port.

Connect a terminal to the console port (port 0) on the router’s rear panel, 
and set the terminal communications parameters to:

•  9600bps

• 8 data bits

• 1 stop bit

• No parity

• Hardware flow control.

2. Restart the router.

Restart the router, either by switching it off and on again using the power 
switch on the rear panel, or by using the terminal to login and enter the 
command:

restart reboot

3. Enable diagnostics mode during start-up.

During the router start-up process, press [Ctrl/D] on the terminal to enter 
diagnostics mode when you see the following prompt:

Force EPROM download (Y)?

A banner page is displayed on the terminal (see figure following). This can 
be used to check that the terminal is correctly connected. 

* * * Diagnostic Mode * * *

  version: 1-Jul-2004

Main Menu:
  0. Restart
  1. Full RAM test
  2. ROM checksum test
Enter selection ==>
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To run a diagnostic program, enter the corresponding letter or number. There 
are several sub-menus to cover the different options. The following table lists 
keys that control the basic operation of the diagnostics.

Diagnostics are designed to be used with all models of the router, and therefore 
some instances of particular tests are not appropriate for some models. A 
reasonable level of understanding of the system structure is needed to operate 
diagnostics and interpret the results. Diagnostics only require the base CPU 
board to be installed in the system.

To restore the router to normal operation, perform a restart by switching its 
power switch (rear panel) OFF and ON.

For more information   This hardware manual is not intended as a guide to 
diagnostics. Diagnostics are designed to be run by service personnel only. For 
more information, contact your authorised Allied Telesyn distributor or 
reseller.

Lithium Battery Replacement
The routers have a replaceable lithium battery. If replacing the battery, use a 3V 
lithium button cell, type CR2032 or equivalent. 

The battery should be replaced when the router:

■ has been in storage for more than two years

■ has only been powered up intermittently over a two year period

■ loses its time setting

! Warning   Batteries should be replaced by authorised service personnel 
only. Unauthorised opening of the router lid may cause danger of 
injury from electric shock, damage to the router, and invalidation of 
the product warranty. 

Contacting Us
With locations covering markets in North America, Latin America, and 
Europe, Allied Telesyn provides local sales and technical support worldwide. 
To find the representative nearest you, visit Allied Telesyn on the Internet at 
www.alliedtelesyn.com.

Key Function

Q Quits any running tests and displays the banner page.

S Prints a summary of test results so far.
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